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Chapter 2: Starting Modeling with EZNEC 
 

 Basic EZNEC Operation 
 

 With EZNEC is installed on your computer, it's time to introduce you to EZNEC's most 

frequently used controls and data-entry mechanisms. As with most things in life, we need to start 

with some boring stuff to establish a firm foundation. Modeling has its own terminology, jargon, 

rules, tricks, quirks, guidelines, limitations, and perhaps frustrations. However, most aspects of 

antenna modeling are quickly familiar when you have some antenna design experience. Other 

aspects might take some time to understand and master. As with so many activities in life, it often 

comes down to working through a few examples and getting past some pesky hurdles. As you use 

EZNEC, you will gradually get comfortable with the way the antenna model is constructed and 

results computed. 

 

 The first time you run EZNEC, it already has an antenna model installed and ready to go, 

Bydipole.EZ. This file is one of the included examples found in the Ant folder of the EZNEC package. 

All the other times you start up EZNEC, the file LAST.EZ will be loaded, (why and how see later). 

By the way, EZNEC model files have an .EZ suffix. When EZNEC is installed, a file association is 

registered with Windows. So if you double-click an .EZ file, you will end up in EZNEC. However, 

EZNEC does accept or create several other file extensions for data related to models (see later). 

 

 The EZNEC Control Center – Main Screen 
 

 Run EZNEC by double-clicking on the Desktop EZNEC shortcut. The main Control Center 

window appears - Figure 2.1. This Main Screen is the center and beginning point for all EZNEC 

operations and remains present until the program ends. This Main Screen consists of various parts 

and pieces: 

 

• Menus – The menus contain a wide variety of items, most of which are program-related. 

They are File, Edit, Options, Outputs, Setups, View, Utilities, and Help. Clicking on a menu 

label opens another window for selections and actions. Each of them is well described in the 

EZNEC User Manual but will be handled and explained as we go on. 

 

• Information Window – This window shows information about a number of essential 

parameters or characteristics of the antenna being modeled. Any of the information in this 

window which can be changed is always automatically saved. This includes the antenna 

description title at the top of the window. 

 

• Selection Buttons – These buttons with a right-arrow label (>) allow you to change the 

item shown on the corresponding line. Selections can also be made by clicking anywhere on 

the corresponding line in the Information window. Buttons that do not have a (>) mark 

cannot be changed but display a calculation such as the Wavelength value or the model 

File name. Most selections will open a dialog box or window. The Title line above the 

Information window is also one of the available selections. Any inputs of any parameter are 

done by these Selection Buttons. 

 

• Action Buttons – A set of buttons on the left side of the window to activate specific action, 

such as opening the View Antenna display or starting a radiation pattern calculation. 

 

Note: Hovering the mouse cursors and holding steady for at least one second over any 

button or displayed information in the information window activates a small pop-up label with a 

short description of what they are. For example, hover the cursor over the button View Ant, it will 

pop up "View antenna display". 
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 Like most software, has EZNEC also a built-in Help function. You can open it by clicking the 

Help menu and then Contents. There is also a complete user manual for EZNEC available online 

from www.eznec.com or www.on5au.be/EZNECPro7.html. The manual is 229 pages long. You might 

print it as some readers prefer having a manual available for reference, or you can purchase a 

handy hardcover book. 

 

 
Figure 2.1. The EZNEC Control Center Window, or the Main screen. 

 

 A Model Example 

 

 EZNEC is a Windows-based program that attempts to follow the standard GUI style guidelines 

that make it possible to quickly learn how to operate a new program because it generally operates 

like other windows programs. However, it has its areas to be a little uncommon and, perhaps for 

that reason, confusing for some. 

 

 File Open – Save As 

 

 With most Windows programs, the "File" menu includes the commands "New", "Open", 

"Save", and "Save As". Instead, EZNEC uses what I would name the Open, Save As, and "LAST" 

model. When EZNEC starts, it automatically opens a model file named LAST.EZ. As the name 

suggests, this is the state of the model when EZNEC last terminated. So, whenever you execute 

EZNEC, you start off exactly where you left off in terms of the model contents. Apparently, EZNEC 

updates LAST.EZ continuously, with every model change or when it should encounter a fatal error. 

This means that it is nearly impossible to lose a model due to a program or system crash. Thus, the 

only file that EZNEC automatically opens or saves is the specific name LAST.EZ. It opens it on start-

up and saves it at the end and after all, and any model changes. 

 

http://www.on5au.be/EZNECPro7.html
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 There is not a "Save" command; usually, the "File > Save" menu command, nor the "Control-

S (Ctrl-S)" keyboard command. The program does not prompt you to save your work if there is 

unsaved work when you terminate the program because the current model state is always saved to 

LAST.EZ upon program exit. 

 

 There is no" New" command. This means that the concept of the empty model or model 

without contents does not exist. In other words, EZNEC will not allow you to save a model into a 

file that cannot be executed. For example, a model without a Source. During the running of EZNEC, 

you can delete all Sources, but you can't save that model until you add at least one valid Source. 

EZNEC will not let you run a model or save it to a file unless it meets some minimum level of 

completeness and consistency. This is a common-sense restriction that prevents chaos from 

breaking out. 

 

 If you want to save a model into a file with a particular name, you must explicitly execute 

the Save As command. If you are updating an existing model, you will be prompted to overwrite 

the contents, even if it is the file from which the model came. 

 

 Suppose you created a model "20m dipole" or made changes in that model. Mind, if you are 

uncertain or forget where to leave off at a previous model session, you might be tempted to Open 

20m dipole.EZ, since that's what you thought you were the last working on. The problem is that the 

changes were saved in LAST.EZ and not in 20m dipole.EZ. In fact, 20m dipole.EZ has the original 

model definitions from before the changes you made. So, if you Open  20m dipole.EZ, you will 

actually lose all of your changes from the previous session. Thus, if you want to reload the model 

with the made changes, you do not need to open a file since it was automatically saved in LAST.EZ 

when you exited the program the day before. If the model LAST.EZ is needed for later use, you 

must recover your changes by saving them, such as 20m dipole-b.EZ with the command Save As, 

before you make any new ones. The only time that EZNEC asks if you want to save changes is when 

you try to Open a file and have made changes that were not saved to an explicitly named file. 

 

 Working with EZNEC Model Data 

 

 Building a model involves the following. Specifying where the antenna wires start and end 

seen in a 3-dimensional surrounding. Adding any elements such as sources, loads, transmission 

lines, transformers, and matching networks. Describing the Ground conditions and specifying where 

and how we want to excite the antenna. To start with, I have already done the work for a simple 

half-wavelength 20-meter dipole. So, Open the file [2-1.EZ]. It comprises a single piece of wire 

10.26 m long, at the height of 10 m, fed in the center with a constant current source. If you like to 

have a quick picture of it, you can see the 3D representation of the dipole by Clicking View Ant 

Action Button. 

 

 Wires 

 

 First, let's take a look at how the dipole wire is specified. Click >Wires Selection Button and 

the Wires window is shown - Figure 2.2. EZNEC thinks of antennas in terms of wires, whether the 

actual antenna is made of wire, rods, tubing, or a tower. EZNEC even models flat surfaces as 

collections of wires all connected together. Since you will be using the Wires window frequently, 

the more familiar you become with it, the more ease while creating a model. In my opinion, it's fair 

to say that the heart of modeling is the Wire option. Although we all have a practical understanding 

of what a wire is, in EZNEC, it is a specific term. A Wire is a straight conductor of a certain length 

and diameter with optional insulation. All Wires in a model are made of the same material, such as 

copper or aluminum, etc. The material serves to determine resistive loss and permeability. 

 

 Our simple half-wave dipole consists of one wire, labeled 1 in the No. column. The position 

of the Wire is defined by the 3-dimensional coordinates of its two endpoints, labeled End 1 and End 
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2. The location of each end is specified by three position coordinates: X, Y, and Z; see "X-Y-Z 

Coordinates" below for advanced definitions. The Z coordinate is the height. One end of the wire 

is at Y(m) -5.165 and the other at Y(m) +5.165 (plus-sign is omitted). That makes the wire 10.33m 

long, stretching horizontally along the Y-axis at 10.56 m height. Note: If you prefer working in 

different units than meters, click Other > Change Units … at the top menu of this Wires window. 

  

 The Conn column is empty for each of the ends. EZNEC fills this in automatically to inform 

us if the end of the wire is at a junction with another wire. In this dipole model, there are no 

connections because we have only one wire.  

 

 
Figure 2.2. The Wires window. 

 

 In the Diameter column, we specify the wire size. You can use all sorts of units: mm, inches, 

a fraction of a wavelength, and an AWG (American Wire Gauge). If you use AWG, you must put the 

# sign in front of the number (#12), as an example. However, if Units is set to meter or millimeter, 

then the diameter must be mm or AWG. If Units is set to feet or inches, then the diameter must 

be inches or AWG. EZNEC also allows specifying wire insulation and thickness. I will ignore that for 

now, but if you want to take a look at the columns which let you specify it, check Show Wire 

Insulation checkbox. 

 

 Each Wire has a segment count that is part of the wire specification. This number tells EZNEC 

how to divide up the wire for its calculations. EZNEC treats each segment as a separate small 

antenna with a current approximated mathematically. As you might guess, more segments imply 

more accuracy. Altering the number of segments is often a solution to a problem of poor average 

gain. EZNEC will choose for you with its "Automatic Segmentation feature" if you wish, but its choice 

will often not be the best. See "Chapter 14: Convergence and Average Gain" for an advanced 

study. A helpful rule of thumb is minimal 10 segments per half wavelength for a pattern/gain 

analysis, and more likely twice that number if really accurate impedance values are required. See 

"Chapter 3: Wires" for more explicit information. 

 

X-Y-Z Coordinates 
 

 Any specified wire has two endpoints, End 1 and End 2. Let's temporarily forget the height of 

an antenna, then we can position these two wire ends using a standard coordinate system: 

Rectangular (also called Cartesian) coordinates. A pair of coordinates describe the location of any 

point. 

 

 

 

 

 Rectangular Coordinates 

 

 Rectangular coordinate uses two axes at right angles to each other. See graph in Figure 

2.3a. Any point on the grid can be expressed in terms of its X-Y coordinates. The line that runs 
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horizontally through the center of the rectangular coordinate graph is the X-axis, and the line that 

runs vertically through the center of the chart is the Y-axis. The point at which the two axes cross 

is called the origin, where the numeric values on both axes are zero. We can write this as (X0, Y0), 

but often labeled 0 on a graph. Left from that original zero point along the X-axis has a negative 

value and right a positive value. A point above the original along the Y-axis has a positive value, 

and a point below, a negative value. The graph defines two points: point (A) at location X3, Y4, 

and point (B) at location X-2, Y-4. 

 

 
Figure 2.3a. Rectangular or Cartesian coordinates 2-Dimensional system. 

 

The X and Y axes are usually the horizontal plane in antenna modeling. But we need a third 

axis to position any point at a given height, the Z-axis. This creates a 3-Dimensional system of 

coordinates with two extra planes: XZ and YZ, Figure 2.3b. The origin point is at ground level, and 

any point higher above ground has a positive value. However, if the antenna is being modeled in 

"free space", there is no ground surface or height, and we can position a point along the Z-axis 

below the origin by giving it a negative value. Modeling a square loop or a quad antenna can be 

more easily modeled by specifying the wire ends left, right, above, and below the origin, in free 

space. Once the model is complete, lift all the wire above the origin or ground level by using Wire 

> Change Height by in the Wires window. 
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Figure 2.3b. The three rectangular coordinate planes. Each pair of axes creates a plane in which 

the coordinate for the third axis is zero. For example, all points in the XY plane have a Z coordinate 

of zero. 

 

 Thus, by using three axes, we now have X-Y-Z coordinates, and we can specify a point 

location anywhere in space. In Figure 2.3c, the indicated point is at 4 units left of the X-axis (X-

4), 4 units in front of the Y-axis (Y-4), and 5 units above ground (Z+5). The + sign may be 

omitted. If you include it when specifying a wire end, EZNEC will remove it anyway. 

 

 There are guidelines and conventions for modeling and positioning a wire in a particular 

plane or direction. These "rules" make models a bit universal to the reader-modeler. It's not an 

absolute must, but best followed-up, read "Chapter 13: Modeling Conventions and 

Guidelines". 
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Figure 2.3c. 3-Dimensional coordinate system to specify a point location anywhere in space. 

 

 Sources 

 

 After defining wires and their segments, the next object we need in modeling is the Source. 

At a minimum, a model must contain at least one wire and at least one source. Placing a source 

tells EZNEC where and how to excite the antenna. Click the >Souces Selection Button, and the 

Sources window is shown, Figure 2.4a. EZNEC always places a source in the middle of a segment. 

Each Source in a model gets the number shown in No. In Specified Position, we must define on 

which wire we place the source. Further, we must tell where on the wire by giving a % from the 

wire End 1. Since mostly the source of a half-wavelength dipole is at its center, we define 50%. 

EZNEC will calculate its Actual Position and tell you which wire segment this will be. In our dipole 

example, this will also be 50% from the wire End 1. Since we defined 11 segments, the center is 

segment 6. So, if we want to insert a source at the exact center of a wire, we must always define 

an odd number of segments. If I should have chosen to divide the wire into 12 segments and 

specified to place the source at the middle (50%), EZNEC should have calculated to put the source 

at segment 6 but 44.83% from wire End 1. Suppose you want an OCF (Off Center Fed) dipole fed 

at 33% from wire End 1, EZNEC puts the Source on segment 4 at 31.82% from wire End 1. Thus 

obviously, the more segments you divide a wire into, the closer EZNEC will be able to position a 

source to where you want it, and if you wish to things centered, use an odd number of segments. 
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Figure 2.4a. The Sources window. 

 

 The last column in the Sources window specifies the source type. Click in the end cell, and a 

drop-down box will enable us to select either a current source (I), a voltage source (V), a split 

current source (SI), or a split voltage source (SV) - Figure 2.4b. For most of our modeling, a 

current source is what we need. Although, in the following coming example models, I will show 

where a split source is valuable or a must. Source voltages and currents are like all other EZNEC 

voltages and currents, always RMS values (Root Mean Square). 

 

 
Figure 2.4b. The Source window with its drop-down box to specify the source type. 

 

 The other two cells (V,A) and (deg) allow us to specify the magnitude and phase of the 

current or voltage source. If we have only one source, as in our dipole model, these inputs are not 

really relevant. The default values, 1 Amp and zero degrees, are exemplary, but those cells become 

essential if we have multiple sources with different amplitude and phase relationships. 

 

Ground Type and Description 

 

The ground type has a profound effect on the antenna pattern and sometimes on its 

efficiency and feedpoint impedance. EZNEC provides several choices for modeling these effects, 

Figure 2.5a. The three basic ground types are Free Space, Perfect and Real, and selected via 

the Control Center selection button >Ground Type.  

 

• Free Space is no ground at all, and that the antenna is wholly isolated from reflecting 

surfaces, metal constructions, other antennas, etc. Using Free Space eliminates any 

reflecting surface or object so that antennas have a limitless sphere for their expanding 

radiation patterns. Primarily, Free Space is used to compare gain and performances between 

antennas. 

 

• Perfect is a perfectly conducting ground plane that is entirely flat and infinite in extent. The 

perfect ground is helpful to simulate high conductive ground with a Z coordinate of zero. It 

can also be used for comparing results with textbook or commercial antennas patterns, which 

often make use of this ground. You might be highly surprised when comparing the predicted 
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gain and radiation characteristics of a commercial antenna with the results when you should 

model this antenna over real ground.  

 

• Real ground types are used for simulating actual Earth ground. The Real ground type is 

further subdivided into two models: High Accuracy and MININEC. Unfortunately, neither 

of the two models is faultless, but it is essential to know which to use in a given circumstance 

and the limitations of each. When you use the Real ground option, you also need to specify 

the characteristics of the ground, its conductivity, and it's dielectric constant. These are 

shown at the information window at the Ground Description button. If either Free space 

or Perfect ground is selected, this line disappears from the information window because the 

ground characteristics are then not considered. 

 

The ground characteristics are defined in the Media window, which opens by clicking the 

selection button >Ground Descrip - Figure 2.5b. If you know the constants for your ground, you 

can enter them directly. If not, EZNEC provides a representative assortment of ground types that 

can be easily selected by right-clicking in the Cond. or Diel. Const. cell to open the Ground 

Characteristics window, Figure 2.5c. The Height and R Coord. columns at the right of the Media 

window are only needed when using two different ground media. See "Chapter 9: Adding Ground 

Model". 

 

 The MININEC-type model takes ground conductivity and dielectric constant into 

consideration when it calculates the radiation pattern and gain. However, it considers the ground 

as perfect when calculating the impedances and currents. A connection to MININEC-type ground 

has zero resistance, so there is no ground conduction loss. The MININEC-type ground results in 

faster calculation than High Accuracy ground and is satisfactory if the antenna does not contain any 

horizontal wires lower than about 0.2 wavelengths or higher if the wire is much longer than a half 

wavelength. The MININEC-type ground is preferable when modeling grounded wires, such as 

verticals. In that case, a load must be added to grounded wires at the grounded segment to simulate 

ground system loss. 

 

 The High Accuracy ground is required for antennas with low height horizontal wires. The 

minimum permissible height for horizontal wires depends on several factors, but results should be 

good down to at least 0.005 wavelength or several wire diameters, whichever is higher. Direct 

connection of wires to High Accuracy ground should not be made. If you do, EZNEC will warn you. 

Sometimes it's necessary to make a ground connection and use High Accuracy ground. An example 

of this situation is modeling a Beverage antenna, where a connection to the ground is needed for 

the termination resistor. Another example is a terminated long-wire or a terminated V-array. In 

these situations, the best approach is to approximate a buried radial system by creating horizontal 

radials just above the ground and making the ground connection to the radials. Fortunately, EZNEC 

has an automated radial maker by Wires > Create > Radials. 
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Figure 2.5a. The Ground Type selection window. 

 

 
Figure 2.5b. The Ground Media window. 

 

 
Figure 2.5c. The Ground Characteristics window. 
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 Wire Loss 

 

Different types of metal have different resistance, which can affect antenna efficiency. Wire 

loss is specified by clicking the >Wire Loss line in the Control Center Information Window. This 

opens a dialog box allowing you to choose from several common metals or enter the User Defined 

resistivity and permeability, Figure 2.6. Wire loss is especially important to include in a model 

showing low source resistance. In these antennas, wire loss can sometimes be substantial. 

 

• Zero – A perfect zero-ohm conductor, only used for comparisons. 

• Copper – Use this selection for stranded and solid copper wire. Also, copper-plated wire 

such as Copperweld EZNEC considers the skin effect depth. 

• Aluminum – This is the right choice for aluminum (6061-T6) tubing or rod constructions. 

• Tin – Can be used for tinned wire and solder-coated surfaces. 

• Zinc – Can be used for galvanized steel, such as towers. 

• User defined – Allow you to enter your resistivity and dielectric constant values. 

 

Your selection will be displayed in the information window.  

 

 
Figure 2.6. The Wire Loss window. 

 

 Frequency and Wavelength 

 

 Any antenna model is designed to be best performing for a particular frequency. It's usually 

the goal that the feedpoint reactance is zero or as close as possible at this working frequency. The 

jX part of the Impedance R ± jX result value displays the reactance. This reactance can be a positive 

or a negative value. When positive, the antenna is resonant somewhere at a lower frequency (the 

antenna is too long); when negative, the antenna is resonant somewhere at a higher frequency (the 

antenna is too short).   

 

Frequency shows the current frequency or sweep on if the Frequency Sweep option is 

enabled. Click >Frequency to define or change the frequency. Check the Rescale box to rescale 

your model to another frequency, Figure 2.7. This might be handy. See "Chapter 3: Wires". 

 

Wavelength shows the calculated wavelength in the current units. This is for information 

only and can't be changed. 
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Figure 2.7. The Frequency window. 

 

 Some Computed Results 

 

 Once you have created a model by defining all of the needed parameters, EZNEC is ready to 

simulate a real antenna based on the parameter data displayed in the information window. The 

simulations can generate various outputs: radiation patterns, SWR graphs, feedpoint (source) 

impedance, etc. Clicking most of the Action buttons activates the calculation engine, and the 

Calculation Progress Window appears in Figure 2.8. Several progress bars appear in the window 

as the calculation runs. Which bars appear is determined by the calculations being done. As shown 

on the bars, Progress does not necessarily proceed at a constant rate, so you should not be 

concerned if it seems to speed up, slow down, or occasionally pause as calculations proceed. It 

remains on the screen until the calculations are finished. No other EZNEC operations can occur while 

it's being displayed. It shows several important pieces of information, plus it allows you to terminate 

calculations before they finish. Once the calculation process is done, EZNEC has calculated 

everything needed for any simulations as long as you do not change any parameter on the model. 

 

 
Figure 2.8. Running the NEC-Core. 

 View Antenna 

 

The View Ant display is one of EZNEC's most useful displays, Figure 2.9. With it, you can 

see what the antenna looks like and see changes or mistakes as they are made, look at the currents 

on each wire, see how the pattern is oriented relative to the antenna, and much more. You will find 

it helpful to leave this display open most of the time. New with EZNEC +V6, several model 
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modifications can be done graphically in this display, described separately in "Chapter 10: View 

Antenna" paragraph "Graphical Wire Operations". 

 

 
Figure 2.9. The View Antenna window. 

 

Source Data 

 

The impedance, SWR, RMS voltage, and RMS current at each source can be viewed or printed 

by clicking the Src Dat action button in the Control Center, Figure 2.10a.  

 

 
Figure 2.10a. The source Data window. 
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 When evaluating these source data, we may conclude that our model design is done with 

the trade tricks—practically zero reactance at the design frequency. 

 

The SWR shown is the SWR present on a transmission line connected in place of the source. 

Values are given for 50 ohm and user-specified feedline impedances. The user-specified impedance 

is selected with choice >Alt SWR Z0, here 75-ohm, Figure 2.10b. The SWR is directly calculated 

from the source impedance. Suppose a source is connected to a transmission line model, and you 

want to know the SWR on the transmission line. In that case, the SWR reference impedance must 

match the transmission line's characteristic impedance. 

 

 
Figure 2.10b. the Alternate SWR ZO window. 

 

 SWR Plot Display 

 

The SWR plot display is shown after running an SWR sweep. This, in turn, is started by 

clicking the SWR action button in the Control Center, then entering frequencies or an input file 

name and starting the sweep as described, Figure 2.11a.  

 

The plot shows the impedance seen by each source. The most basic is a graph of SWR vs. 

frequency. The SWR is not necessarily the actual SWR on a transmission line but is the SWR that 

would be on a line if the line were connected between the source and the antenna. 

 

You have the choice for two SWR line characteristic impedance values again. One impedance 

is 50 ohms. The other can be changed to a value of your choice by clicking on the >Alt SWR Z0 in 

the Control Window, Figure 2.11b. Also, in the Control Window is a selector allowing you to choose 

the source to display the SWR in the event your model has more than one source. 

 

Additional information appears in the Data Window below the plot. The Data Window is 

turned on or off from the View menu. In this window, you can see the impedance reflection 

coefficient and return loss as the SWR. 

 

The cursor can be moved by clicking on the display window or dragging with the mouse. You 

can also use the arrow keys after clicking once on the display window with the mouse to ensure the 

display window has the focus. 
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Figure 2.11a. The SWR Sweep Parameters window. 

 

 
Figure 2.11b. SWR 50-ohm plot. 

 

FF Plot 

 

 Before generating the FF plot, you first define the step size number by the >Step Size 

selection button - Figure 2.12a. The lower the number, the higher the accuracy of the plots, but 

the slower the calculation. A good value is from 1 to 5. 
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Figure 2.12a. The plot Step Size window. 

 

 FF Plot stands for Far Field Plot. This Action Button generates radiation plots, as you find in 

articles and books about antennas. Immediately after the calculations are finished, a radiation 

pattern is displayed. Depending on your previous Plot Type selection, it will be a 3D or a 2D plot, 

Figure 2.12b. I prefer the 3D plot type - Figure 2.12c, from which it is always easy to switch to 

any 2D elevation or azimuth slice plot.  

 

 
Figure 2.12b. The Plot Type Size window. 

 

 The 3D pattern can be rotated in any direction by holding down the left mouse button while 

you move the mouse. The 3D plot is always oriented in the same direction as the antenna in the 

View Antenna display, after releasing the left mouse button following perhaps 3D or view Antenna 

rotation. It is also handy to familiarize yourself with the many menu operations common among all 

the EZNEC graphical displays. Explore the Menu options: File, Edit, View, Options, and Reset. For 

example, via View, enable and disable: Show Controls, Show Data, and Show Data Lines. 

Many more handy commands are available as Print, Copy, Save, and others, which (where and 

when convenient) will be handled in more depth later.  

 

From the 3D plot, it is easy to switch to 2D radiation plots, either by activating its checkbox or via 

the Menu View−>Show 2D Plot. A 2D plot will look like Figures 2.12d and 2.12e. The pattern 

is plotted on polar coordinates in the upper part of the window and data about the pattern in the 

text area below the pattern. The data might be subdivided as shown in Figure 2.12d. You can 

switch to a full-screen version by clicking the Maximize symbol at the window's upper right. From 

the Data, you read that the outer ring of the polar plot represents a gain of 7.34 dBi for the 20-

meter dipole 10 m (±1/2 wl) above average ground. The Front-to-Side is 10.78 dB, and the -3 dB 

Beamwidth is respectively 33.2° for the elevation slice and 85.8° for the azimuth slice. Of course, 

a lot more is available with those radiation plots. I will handle the Polar plot patterns and numeric 

Data in more depth in "Chapter 12: Far Field Patterns". 
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Figure 2.12c. The 3-D pattern plot with Step Size 5. 

 

 
Figure 2.12d. The elevation pattern plot with Data Lines enabled. Two lines at the -3dB angles 

(13.1° - 46.3°) and one at the maximum gain angle (28°). 
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Figure 2.12e. The azimuth pattern plot with Data Lines enabled. Two lines at the -3dB angles 

(47.1° - 132.9°) and one at the maximum gain angle (90°). The text data area might be divided 

into three sorts of data: pattern specifications, cursor specifications, and pattern measurements. 

 


